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QA/QC Functionality in MARS® version 2023.0 

 

1. Check Point Report 

a. Inputs section 
b. Statistics and Standards sections 
c. Redraw Thematically 
d. Histogram 

2. Raster QC Tool 

3. LAS Statistics 

a. Created During Tile Scheme Generation 
b. Run on Single or Multiple Classes 
c. Run During Collection Scan Polygon Generator to Report Statistics per Collection Scan 
d. Run on an Existing Tile Scheme 

4. ‘LiDAR Spatial Distribution Verification GRID’ Tool 

5. Cross-Section/Profile 

6. ‘Rotate Profile’ Tool and Hot Key 

7. Color bys 

a. Elevation Color Repeat 
b. Intensity Color Extremes 
c. Blend with Intensity 
d. Collection Scan 

 
8. ‘Lock to View 100%’ Tool 

9. Contours 

a. In Export 
b. With Breaklines 
c. Color 
d. 100% View 
e. ‘Contour Join’ Tool 

10. ‘Swipe’ Raster Over LiDAR Tool 

11. ‘Coverage Tracking’ Tools 

12. Contour by Collection Scan 

13. Check for Crossing Breaklines 

14. Scale Bars 

15. ‘Collection Scan Direction’ Option 

16. Z Delta/Flight Line Separation – JPEG 2000 
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17. Hillshade 

a. Color by 
b. Export to JPEG 2000 

18. Ability to Add and View a Float Grid in 2D or 3D 

19. ‘Flood Fill’ Tool 

20. Real-time LAS Shifting 

a. LAS Shifting (X, Y, and/or Z) 
b. Z Shift on Intensity 
c. Z Shift on Class 
d. Z Shift For LAS Files 

21. ‘Collection Scan Polygon Generator’ Tool 

22. ‘Swath shapes to overlap JP2’ Tool 

23. Batch Script Test Function to Step (Forward and Back) Through Macros 

24. ‘Convert SBET to Shapefile’ Tool Coupled with ‘Scan Angle’ Filter 

25. ‘Single Collection Scan to Multiple’ Tool 

26. ‘Z Fix Using Stream Rule’ Tool 
 
 
MARS Technical Support information 
 
 
 
 
 
 
 
 
 
 
 
**PLEASE NOTE that many additional QC tools can be found within the QC Module, available 
with either an Explorer QC or Production license.  Please see the MARS® website: 
 
https://www.merrick.com/site/static/mars/documentation/Benefits_of_MARS_v2023.0_QC_Module.pdf 
 
or the Help Topics within the software for details. 

 

 

 

 

 

https://www.merrick.com/site/static/mars/documentation/Benefits_of_MARS_v2023.0_QC_Module.pdf
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1. Check Point Report: 
Once LiDAR data has been corrected for any systematic errors, the project’s ground check points can be validated 

against the derived LiDAR ground surface via the Check Point Report utility within MARS®.  This tool verifies the accuracy 

requirements for the LiDAR data and serves as the critical tie between project control and coordinate systems.  MARS® 

allows the user to specify the desired vertical accuracy for the statistical analysis of the check points and can also 

generate a hard-copy check point report.  In short, this tool compares the accuracy of the remotely collected data with the 

known points on the ground, which can help uncover data integrity issues within the dataset.  To generate a check point 

report, check point data must be loaded along with the corresponding LiDAR data.  Check points must be stored in either 

a MARS® compatible *.CSV or *.SHP file.  To generate a check point report, click the ‘Check Point Report’ button on the 

‘QA/QC’ tab.  The first time the check point report is created, a prompt asks which point classifications to include in the 

report calculations, as well as the calculation method and vertical units for the loaded LiDAR points.  Once these settings 

are made click the ‘OK’ button and the ‘Check Point Report’ interface will appear (see below). 
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a. Inputs section: 

• ‘Requirement’: This is the target vertical accuracy requirement (in metric units).  During the calculation of the check 

point statistics, comparisons are made to these values to see if the desired vertical accuracy is met.  
 

• ‘Elevation Calculation Method’: There are two elevation calculation methods: TIN and Grid (TIN is the default).  In 

‘TIN’ mode, a TIN is created around each enabled check point, using LiDAR points in the included class(es) within 5 

units of horizontal distance.  The one triangle that covers the check point XY location is then selected.  The location on 

the surface of this triangle that matches the XY location of the check point provides the elevation value of the surface. 

This elevation value is a linear interpolation of the elevations of the three TIN vertices.  Simply put, it is the point in 3-D 

space on the TIN triangle at the check point’s XY location.  The second method, 'Grid', allows the use of a virtual grid 

for check point report statistics to be generated on rather than the actual TINned LiDAR data.  The purpose of 

calculating a check point report on virtually gridded data is to report the accuracy of generated elevation grid products 

(DEMs) and any contours produced from them.  Options when using the 'Grid' method include the 'Grid Cell Size' and 

the 'Gaussian Smoothing Count'.  A large grid size interpolates more varying elevation as a single grid cell elevation 

value.  The smoothing count value tells the software how many times to smooth the data - more smoothing results in 

less accuracy. 

 

• ‘Search Radius for 3 points (TIN)’: This value is calculated from the loaded LAS data.  The default value is five times 

(5x) the Ground Sample Distance (as determined through testing) but can be modified.  Too small of a value will result 

in some check points not being compared to their surrounding LAS data - this may be the case when the 'Points with 

Coverage' value in the 'Statistics for NVA Points of Project' section is less than the 'Check Points' count, causing some 

points in the 'Statistics per Check Point' section to have mostly blank values.  Too large of a value may result in overly-

long processing times. 

 

• ‘Classifications Included’: This list box shows which data classifications are to be used to calculate elevation for 

either the TIN or Grid method. By default, class 2 (Ground) is selected. 

 
 

b. Statistics and Standards sections: 
 
• RMSEz Requirement: This is the target root mean squared error (RMSEz) value for the project, which defines the 

vertical (Z) accuracy requirement.  The user may specify either the RMSEz value or the vertical accuracy requirement. 

During the calculation of the check point statistics, comparisons are made to the RMSEz value to see if it meets the 

desired accuracy requirements.  To achieve the target accuracy requirements, the calculated RMSEz value is 

compared to the target value to determine if the check points are within an acceptable margin of error to be labeled 
‘PASS’. 

 

‘Statistics for NVA Points of Project’: 
• Check Points: This is the total number of check points in the project. 
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• Points with Coverage: This is the number of check points with an elevation value that can be computed from nearby 

LiDAR data.  More specifically, when computing the Z elevation from a TIN, this is the number of check points where 

a covering triangle is found. 

• NVA Points: 
• VVA Points: 
• Average Vertical Error: For all check points with coverage, this is the average value of the ‘Z Error’. 
• Maximum Vertical Error: For all check points with coverage, this is the highest positive ‘Z Error’ value. 

• Median Vertical Error: For all check points with coverage, this is the median of the ‘Z Error’ values. 

• Minimum Vertical Error: For all check points with coverage, this is the lowest negative ‘Z Error’ value. 

• Standard Deviation of Vertical Error: This is the standard deviation of the ‘Z Error’ for the check points. 

• Skewness of Vertical Error: 
• Kurtosis of Vertical Error: 
• RMSE of Z for Sample: This is the RMSE of the Z value from the data as compared to the check points. 

• FGDC/NSSDA Vertical Accuracy: This value, derived from the RMSE of Z for the check points, is the vertical 

accuracy as defined in Geospatial Positioning Accuracy Standard, Part 3, National Standard for Spatial Data 

Accuracy, FGDC-STD-007.3-1998.  It is the RMSE value multiplied by a factor based on the confidence level.  For the 

95% confidence level, the multiplication factor is 1.96. 

If this value is less than the ‘Vertical Accuracy Requirement’ value, then the result is labeled as ‘PASS’ on the 

Check Point Report dialog (to the right of the ‘FGDC/NSSDA Vertical Accuracy’ value). 

 
c. Redraw Thematically: 

Shows the Z error calculated in the report thematically.  Red represents negative error (surface lower than check point) 

and green represents positive error.  The relative size of the error is represented by the size of the square shown.  The 

larger the square, the larger the Z error. 

 
 
 

d. Histogram: 
This button presents a histogram of the 'Z Error' for the NVA points with the amount of error on the X-axis and the 

number of occurrences within specified error ranges on the Y-axis.  If there are VVA points in the loaded check points 

CSV file, a 'VVA' button will be available at the bottom to switch to a separate histogram for those points.  The 

Histogram window also contains a button labeled 'Redraw Thematically', but it functions differently in this location than 

the button described in item 9, above.  In this case, clicking it will apply a color ramp to the default-yellow bars in the 

histogram, better differentiating the amounts of Z-error.  The color ramp uses up to 24 discrete shades, ranging from 

red for the largest amount of negative Z-error, to green for near-zero Z-error, to magenta for the largest amount of 

positive Z-error.  In the LAS Map View window (main MARS® view), the check points that fall within each of the 
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Histogram error ranges (bars) will be displayed in the same color as the bars themselves.  Clicking the 'Back' button 

on either histogram display will return to the interactive report window. 

 
 

2. Raster QC Tool (available with Production license only): 
The purpose of the Raster QC tool is to provide an automated tool for verifying the format, structure, and contents of 

certain types of raster products.  The types of rasters that can be tested are DEM (Digital Elevation Model), MSHR 

(Maximum Surface Height Raster), and Intensity.  All rasters are expected to be in GeoTIFF format.  In addition, testing of 

water body flatness can be done if polygonal 3D breaklines are included with the inputs. 

 

The output of this tool is a report in TXT format and an attributed tile-based shapefile for each of the input raster datasets. 

Each output shapefile will be an enhanced copy of the input Tile Scheme shapefile (described below) with attributes 

populated specific to the dataset it represents. 

 

Inputs 
A minimum of one of the three possible raster types must be selected to run the tool.  Each raster type must be in a 

different folder (any sub-folders are ignored) and must adhere to a specific naming format with a '.tif' extension.  For the 

DEMs, the file names must begin with 'DEM_'; for MSHRs, the names must begin with 'MSHR_'; and for Intensity rasters, 

the names must begin with 'INT_'.  For example, one tile's rasters might be named  

'DEM_111ABC.tif, 'MSHR_111ABC.tif', and 'INT_111ABC.tif'. 

 

In addition, a Tile Scheme in polygon shapefile format and a DPA (Defined Project Boundary), also in polygon shapefile 

format, must be supplied.  The Tile Scheme must contain an attribute that is populated with the unique names of the 

rasters.  For example, if the DEM rasters are named 'DEM_111ABC.tif', 'DEM_222ABC.tif', 'DEM_333ABC.tif', etc., there 

must be an attribute populated with '111ABC', '222ABC', '333ABC', etc.  There should be a one-to-one correlation 

between the Tile Scheme shapefile and the raster files in each input dataset.  In other words, if the Tile Scheme contains 

657 uniquely named tile features, there must be 657 matching rasters for each dataset that will be tested.  
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Usage 
At least one type of supported raster must be supplied in the 'Input Raster Folders' section of the tool interface.  Use the 

'Browse...' buttons to the right of each raster type to navigate to and select a folder containing the rasters to be tested. 

Use the 'Browse...' buttons to the right of the 'Tile Scheme' and 'DPA Boundary' entry boxes in the 'Shapefiles' section to 

select those required shapefiles.  Select the attribute field that contains the unique raster file names in the Tile Scheme 

shapefile using the 'DB Field (Required)' drop-down list.  To include water body breaklines for the optional flatness 

testing, use the 'Browse...' button to the right of the 'Shapefile for 3D breaklines for water bodies' entry box to select the 

shapefile. 

 

Minimum and Maximum elevation values for any cell are pre-populated with '-999' and '15000' respectively, but these can 

be changed as needed for each project. MARS® is unit-less, so use values that make sense for the project area and 

coordinate system units.  These values will be used to flag possible problem elevations in the final reports. 

 

Finally, select an Output Folder for the final text file reports and shapefiles using the 'Browse...' button to the right of the 

entry box. 

 

When all needed entries have been made, click the 'Run' button to begin the processing - a progress bar is located 

directly above this button.  A 'Report Completed' message will appear when the tool is finished. 

 

Output 
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In the selected Output Folder, one text file report will be stored for each of the tested datasets.  For the DEM dataset, this 

final report will be named 'DEM_report.txt'.  The MSHR and Intensity reports will be named accordingly. 

 

Each section will list the name of the value being tested, with the next line(s) showing the actual value and the raster file 

count.   

 

In addition to the text file reports, an enhanced version of the input Tile Scheme shapefile will be generated for each 

tested dataset.  These shapefiles will also be stored in the selected Output Folder.  For the DEM dataset, this shapefile 

will be named 'DEM_tile_layout.shp'.  The MSHR and Intensity shapefile will be named accordingly. 

 

Each tile feature (record) in the shapefile will be attributed with the values from the report, and the attribute fields will be in 

the same order as the corresponding sections of the report. 

 

If any cells with NODATA values exist in any of the tested rasters, a point shapefile for each of the included input raster 

datasets where a NODATA value is present will also be generated in the Output Folder.  These shapefiles will be 

attributed (internally) with the XY location of each NODATA cell.  Additionally, if any non-flat breaklines vertices are found 

during testing, a point shapefile for each affected tile will be generated under the DEM output folder. 

 

 

 3. LAS Statistics 

a. Created During Tile Scheme Generation: 
In order to produce LAS Statistics during the creation of a unique tile scheme, the user must first access the ‘Create Tile 

Scheme’ interface.  This can be done by clicking the ‘Create Tile Scheme’ button on the ‘Vector Creation’ tab.  After 

defining all the specifications to create a tile scheme, make sure that the ‘Calculate LAS Statistics, and save to Attribute 

Table’ option is chosen. 
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 ‘Calculate LAS Statistics, and save to Attribute Table’: This tool allows the user to create statistics for each 

tile.  By choosing this option, the user will make the 'Class Statistics' option available.  The user may then select the 

classes on which statistics will be created.  Checking this option will populate the following statistics and make them 

available to the user through the attribute table of the tile shapefile as shown below: 

 

ID:  A uniquely-generated ID number for each tile created. 

TName: The TName is a uniquely-generated tile name with a starting number specified by the user. 

AREA: The area in project units of a particular tile. 

ALLPCOUNT: A count of the total number of points within a particular tile. 

DENSITY: The point density in points per square unit (using first returns only). 
AVG_GSD: The average GSD (ground sample distance). 

X_MIN: The x axis (easting) minimum within a particular tile. 

X_MAX: The x axis (easting) maximum within a particular tile. 

Y_MIN: The y axis (northing) minimum within a particular tile. 

Y_MAX: The y axis (northing) maximum within a particular tile. 

Z_MIN: The z axis (elevation) minimum within a particular tile. 

Z_MAX: The z axis (elevation) maximum within a particular tile. 

Z_DELTA: The difference between Z_MAX and Z_MIN within a particular tile. 

COLL_SCAN: A listing of the different collection scan numbers which overlay a particular tile. 

GPS_MIN: The GPS time (timestamp) minimum found within a particular tile. 

GPS_MAX: The GPS time (timestamp) maximum found within a particular tile. 

MIN_INT, MAX_INT, MEAN_INT, MED_INT, and MODE_INT: Various intensity value statistics. 

RETURN_0: The number of ‘other’ returns found within a particular tile (returns that are missing or have incorrect 

point family info).  
RETURN_1 through RETURN_15: The number of first returns through fifteenth returns (listed in individual attribute 

fields) found within a particular tile. 

SYNTHETIC: The number of points bit-flagged as ‘Synthetic’ found within a particular tile. 

MKP: The number of points bit-flagged as ‘Model Keypoint’ found within a particular tile. 

WITHHELD: The number of points bit-flagged as ‘Withheld’ found within a particular tile. 

OVERLAP: The number of points bit-flagged as ‘Overlap’ found within a particular tile. 
Class0 through Class255: The number of points in each class (listed in individual attribute fields) is recorded per 

tile. 

iShape: A MARS®-specific value that is not relevant for the user. 

 

 

It is also possible to view statistics about the attribute values in the tile shapefile.  The user may view the statistics of a 

single attribute (column) for one or more tiles (rows), or the entire table.  Highlight the tiles for which statistics are to be 

viewed, right-click on the desired column header, and choose 'Statistics'.  The resultant pop-up table will show the user 

the following statistics: row (tile) count, minimum, maximum, sum, mean (average), and median of the chosen attribute. 

To select multiple rows for viewing at once, use the 'Shift' or 'Ctrl' keys on the keyboard. In the example below, the user 

is choosing to view the ‘ALLPCOUNT’ statistics of all tiles. 
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b. Run on Single or Multiple Classes: 
To create LAS statistics on single or multiple classes the user must choose the desired class(es) for which to populate 

statistics in the ‘Statistic Classes’ GUI.  This interface will appear when the user clicks the ‘Select’ button to the right of 

the ‘Class Statistics’ box on the ‘Create Tile Scheme’ interface (see above).  Choose the class or classes for which 

LAS Statistics are to be populated. 
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c. Run During Collection Scan Polygon Generator to Report Statistics per Collection Scan: 
Statistics can also be run to calculate first-return density and GSD per collection scan in the ‘Collection Scan Polygon 

Generator’ tool.  This tool can be found on the ‘Vector Creation’ tab and allows the user to choose which classes to run 

statistics on and whether to use a Grid or virtual TIN to determine the boundary of each collection scan.  The statistics 

stored in the resulting shapefile are identical to those listed in Section a. (above), except that ‘TNAME’ is replaced by 

‘FILENAME’ to indicate the collection scans processed. 

d. Run on an Existing Tile Scheme: 
In order to produce LAS Statistics on an existing tile scheme, click the ‘Populate Statistics on Tile Scheme’ button on 

the ‘Analysis’ tab.  The shapefile for which the user would like to populate statistics must first be loaded as the tile 

shapefile within MARS®.  Using this tool will create a new tile shapefile in the same folder where the loaded tile shapefile 

exists; it will contain populated fields for the attributes listed in Section a. (above).  Additionally, 256 columns will be 

added to the end of the table that list the Model Keypoint bit flag count per class (ClassMK0 through ClassMK255).  The 

file will be named ‘<input tile shapefile name>_With_LAS_Statistics.shp’ 

 

 

4. LiDAR Spatial Distribution Verification GRID Tool: 

This tool is used to create a grid that contains values representing the presence (value=1) or void (value=0) of a first (of 

any) return LiDAR point within any portion of a predefined grid cell size.  This tool creates a JPEG 2000 as the final 

product.  The development criteria for this tool were based upon the USGS LiDAR Base Specification 2021 rev. A (June 

2021 and subsequent revisions), as stated: 

‘The spatial distribution of geometrically usable points will be uniform and regular.  Collections will be planned 
and executed to produce an aggregate first return point data that approaches a uniform, regular lattice of points. 
The regularity of the point pattern and density throughout the dataset is important and will be assessed by using 
the following method:  

 

• Assess only nonwithheld, first return points of a single File Source ID.  

• Exclude acceptable data voids previously identified in this specification.  

• Generate a density raster from the data with a cell size equal to twice the design ANPS. 

• Populate the raster using a count of points within each cell. 

• Ensure that at least 90 percent of the cells in the grid contain at least one lidar point.  
 

The USGS–NGP may allow lower passing thresholds for this requirement in areas of substantial relief where 

maintaining a regular and uniform point distribution is impractical.’' 
 

To use the 'LiDAR Spatial Distribution Verification Grid' tool: 

1) Start by loading the LAS data for the project to be analyzed. 
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2) Click the 'Export'  button to see the drop-down list of export types.  Select 'LiDAR Spatial Distribution 
Verification GRID - JPEG 2000' and click the ‘OK’ button.  A screen shot of the export interface that pops up is 

shown below. 

 

 

3) When the export interface appears, specify an Output Directory.  The output directory will be the folder in which the 

final JPEG 2000 (*.jp2) and auxiliary text file can be found after processing is complete.  

4) The 'Use temporary local disk space to speed up processing' option allows the exported file to be written to the 

specified 'Output Directory', but uses local disk space to speed up processing.  A typical situation for this option is 

when the 'Output Directory' is a network location.  To use this option, check the 'Use temporary local disk space to 

speed up processing' box.  Browse to any local folder which has available space - the export interface will display 

how much space is required (for Single File layout raster exports) and how much free space is in the folder 

selected.  If there is enough disk space, the export process will use the local space to speed up processing. 
NOTE:  Most versions of Windows prohibit an application's output of files to the root directory of drives.  It 
is strongly recommended that an actual folder be used for this option. 

5) On the 'Layout' tab of export, specify a File Name for the newly created .JP2 file in the 'File' text box.  Because the 

USGS specifications are for use with an entire project and not tiled data, this tool is intended for use with the 

'Single File' (when using the 'Export' button) or 'User-defined Box' (when using the 'Export Area' button) layout 

types. 

6) The ‘Grid’ tab contains a few options to control the export.  The 'Number of points required in cell' option sets a 

minimum point count required within each cell.  The default value is '1' (to meet USGS specifications), but it can be 

changed as needed.  The 'Exclusion Shapefile' option is meant for use with a polygon shapefile.  A typical polygon 

shapefile for this use will contain polygons around all water bodies which may cause the resulting output grid file to 

produce a '0' (zero) value.  A '0' value would indicate that no LiDAR point was found inside that particular cell, and 

that cell would then 'fail' the test as described above.  If all the cells found inside a body of water record a '0' value, it 

could cause the entire project area to fall below the 90% pass rate of cells containing a value of 1 (cells which 

contain at least one point).  Because LiDAR is absorbed by water, water areas should be excluded from the test 

results.  The 'Exclusion Shapefile' option allows the user to place polygons around any water bodies which may 

result in a '0' value and exclude those polygons from the results.  Using this option when producing a LiDAR Spatial 

Distribution Verification Grid is optional. 



February 1, 2023 Page 13 

       

The 'Minimum Zero Count to set NODATA value' option may be applied in areas where a large number of '0' 

value cells is anticipated, as in the case of a water body.  This option implements a maximum number of contiguous 

'0' cells and changes the value of those '0' cells to a value of 'NULL'.  This will automatically delineate large data 

void areas such as water bodies.  This option can be used as an alternative to the 'Exclusion Shapefile' option and 

completes the same general purpose.  After checking the 'Minimum Zero Count to set NODATA value' option, 

the user may enter an integer in the adjacent text box.  As an example, if the user entered '3' into this text box, the 

process would look for three contiguous cells containing a '0' value and change all three to a 'NULL' value. The 

purpose of this option is to create a more accurate pass percentage if no exclusion shapefile exists. 

 

At the bottom of the 'Grid' tab is the 'Auto boundary algorithm' option.  The boundary of the LiDAR data will be 

automatically detected and a NODATA value will be assigned to the raster cells that fall outside the boundary.  The 

detection methods vary depending on whether the input LAS data is in 'Swath' or 'Tile' (the default) format.  Swath 

data is assumed to have only one Point Source ID (PSID), also called collection scan number, per file, and adjacent 

swaths will overlap each other.  Tile data may have one or more PSIDs per file, and adjacent tiles will not have any 

overlap.  Note that there may be overlap within a tile, as when two or more swaths fall within a tile's boundary.  The 

correct choice of input type is important in avoiding gaps in the exported grids within the project area. 

 

7) The multi-threading tool is available for this export type.  It functions to speed up export by using a specified 

amount of a computer’s CPU processing power.  The multi-threading option can be found at the lower-right corner 

of the export interface.  Initially, the box will show the maximum number of threads the computer has available for 

processing.  Leave as is, or enter a lower number of threads to use in processing here.  If ‘1’ is typed inside this 

text box, it is equivalent to single-threading the process.  For best performance, there should be a minimum of five 

(5) GB of RAM available (not just installed) per thread. 

 

8) If any other parameters need to be set, please enter those settings on the appropriate tabs of the export interface. 

9) When all the parameters of the export have been set, click the 'Export' button at the bottom of the interface. 

10) When the export has completed successfully, a prompt will appear.  
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Below is an example result of the LiDAR Spatial Distribution Verification Grid tool.  The green areas represent cells with a 

value of ‘1’, meaning they have at least one LiDAR point within the cell.  The red areas represent cells with a value of ‘0’, 

meaning they DO NOT contain any LiDAR points.  In the example below it is easy to see that there is a body of water 

running through this area, which is the cause of the red cells with a ‘0’ value.  If the user were to implement the 'Minimum 

Zero Count' option when running this tool, the areas of contiguous ‘0’ cells (the water body) would return a ‘NULL’ value 

instead of a ‘0’ value.  

 
 

The 'LiDAR Spatial Distribution Verification Grid' tool will also output a results text file (*.txt) every time the tool is used. 

This file will be output to the same location as the JPEG 2000 (the location specified by the user in the output directory 

browse box).  The text file will be named beginning with the date, time, and 

‘…LiDAR_Spatial_Distribution_Verification_Results.txt’.  This allows each *.txt created to be unique.  For instance, the file 

seen in the screen shot below was produced on February 2, 2011, at 2:45 pm. 

 

 
The text file will contain the following information: the number of cells with a ‘0’ value, the number of cells with a ‘1’ value, 

and the number of value = ‘1’ cells as a percentage of the total number of cells.  This last value will be the percentage of 

passing cells.  This percentage needs to be 90% or above to comply with the USGS specifications mentioned above.  The 

screen shot below shows an example of the information contained in the text file. 
 

 

 

5. Cross-Section/Profile: 
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The cross-section/profile tools are useful in evaluating data for calibration (collection scan/mission alignment) and 

obtaining measurements from elevation data.  Cross-sections and profiles can also be exported.  This tool first allows the 

user to see a ‘cross-section’ through the data.  A cross-section has more depth than a profile, which is only a linear cut 

through the data.  To create a cross-section (which will appear in a separate ‘MARS Profile View’ window) use the 'Place 

Cross-Section Line'  button or the 'Place Adjustable Cross-Section Line'  button to create a cut through the 

point cloud or TIN.  Even if the data in the LAS Map View window is being rendered as a TIN, the ‘Cross-Section/Profile 

View’ window will render the data as LiDAR points. 

As mentioned above, there are two methods for cross-sectioning data: 

1.  Place Cross-Section Line: This tool requires the user only to select the length of the cut and defaults to 

the depth set in the 'Options tab  Miscellaneous Options Default cut area depth’. 
 

 

2.  Place Adjustable Cross-Section Line: This tool requires the user to select the length and depth of the cut.  

The button is located immediately to the right of the ‘Place Cross-Section Line’ button. 

 

There are three ways to view the resulting data in the ‘Cross-Section/Profile View’ window: 1. by the Cross-Section 

view, 2. by the Profile by Collection Scan view, or 3. by the Profile Combined view. 

1.  Cross-Section: The Cross Section view will create a cross-section of points in the cross-section/profile 

area.  To modify the sizes of the LiDAR points in the cross-section/profile window, click the ‘Show Point 

Size’  button.  This action will cause the points closest to the ‘observer’ to be displayed 

relatively larger, while those points on the far side of the cut depth will be displayed relatively smaller.  

2.  Profile by Collection Scan: This view will render the points in a unique color by collection scan. 

3.  Profile Combined:  The Profile Combined view will combine the points from all applicable collection scans 

and display the profile line as an average elevation. 
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To exaggerate the scaling of the cross-section/profile window display, the user can slide the ‘Vertical Scale’   

slider bar inside the cross-section/profile window or simply type in the scale to be viewed in the text box. Click the ‘1x’ 

 button to return the scale to the original, or ‘true,’ state.  This tool is normally used to evaluate the ground control 

points in relation to the classified LiDAR ground points (aka Model Key-points).  Maximum exaggeration is 1000x. 

 

 

6. ‘Rotate Profile’ Tool and Hot Key: 
The ‘Rotate Profile’ tool only functions when the cross-section/profile window is open and allows the user to rotate the 

cross-sectioned/profile area a specific number of degrees in a clockwise (positive value) or counter-clockwise (negative 

value) direction.  To use this tool, click the ‘Rotate Profile' button on the ‘Cross-Section/Profile’ tab after a cross-

section/profile has been created for the area in question.  90 degrees is the default rotational value, but any numerical 

value (including negative) may be entered.  Select ‘OK’ to see the results in both the LAS Map View window and the 

cross-section/profile window.  

 

This tool also has a keyboard accelerator, or hot key, option.  To bring up the rotate window (as shown below) without 

using the button, select the letter ‘R’ on the keyboard when the cross-section/profile window is active.  If the user attempts 

to use the keyboard accelerator when the cross-section/profile window is NOT open, the window will re-open and the view 

will be rotated by the specified amount, IF the cross-section/profile window has been open previously in the current 

MARS® session. 

 
 

7. Color By Settings Used in QC 

a. Elevation Color Repeat: 
Using the ‘Repeat’ option (under the ‘Coloration Options | Elevation’ button on the ‘View” tab) can help the user see 

fine elevation detail in the LiDAR surface. 

The 'Color by Elevation'  button renders the data by relative elevation and is linked to the ‘Elevation’ coloration 

option tool .  The ‘Repeat’ option allows the user to adjust the color repeat cycle on different elevations.  In the 

example below, the screen shot on the left represents 0 color gradations used between principal colors creating a total of 

5 color changes.  The second example on the right represents 10 color gradations between principal colors creating a 

total of 55 color changes.  Much more elevation-difference detail is visible with more gradations. 
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b. Intensity Color Extremes: 
Using the ‘Color Extremes’ option (under the ‘Coloration Options | Intensity’ button on the ‘View’ tab) will highlight the 

min and max ends of the intensity spectrum. 

The view by intensity tool colors the LiDAR data by intensity.  This tool is linked to the 'Color by Intensity'  button. 

The Color Extremes setting allows all extreme intensity values (user-selectable) to be displayed in color instead of 

grayscale.  All points that have an intensity value less than or equal to the ‘Low threshold’ are displayed in blue, and those 

with an intensity value greater than or equal to the ‘High threshold’ are displayed in yellow. 

 

c. Blend with Intensity: 

This visual tool  (on the ‘View’ tab) will display LiDAR points by intensity value and allow the user to blend this display 

with other ‘color by’ views.  Intensity may be blended with elevation, classification, return, collection scan, ground color, or 

AGC.  There is no terrain relief when viewing LiDAR data by intensity alone, but the ability to view intensity along with 

another rendering method may allow the data to be viewed more efficiently.  Please see the following examples for further 

explanation.  

 

In the example below, the LiDAR data is being viewed by return only.  By viewing only the return values, it is impossible to 

know which characteristics in the terrain the first return (blue) or second return (red) data correspond to.  



February 1, 2023 Page 18 

 
 

The example below is of the same area, but the ‘Blend with Intensity’ tool has been utilized with the return values in the 

LiDAR data.  It is now easy to see that the first return data (blue) corresponds to areas with roads and buildings (solid 

surfaces, typically) whereas the second return data (red) corresponds to areas containing trees. 

 
 

d. Collection Scan: 

This tool  (on the ‘View’ tab) colors LiDAR points based on the collection scan they belong to.  Clicking the 'Color by 
Collection Scan' button will render each collection scan’s points by a unique contrasting color as shown in the example 

below.  By displaying this way, the user can identify gaps in the collected dataset or easily see boresighting corrections 

that need to be made.  In addition, visibility and color of individual collection scans may be set with the ‘Edit Collection 

Scan Display’ button  . 
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 8. ‘Lock to view 100%’ Tool: 

This tool  is intended for hand editing purposes and when drawing Virtual Contours.  The density percentage on the 

left side of ‘Status Bar’ tells the user the percentage of LiDAR points which are currently being displayed.  

 

Please see the screen capture below as an example.  The screen shot below shows the user viewing point density at 

100%: 

 
Hand editing should only occur when the user is viewing points at 100% density.  It is easy for the editor to zoom in/out or 

lose/gain point density frequently throughout the hand editing process by maneuvering around the project, and this tool 

allows the editor to lock the point density of the display at 100%.  To use this tool, zoom into the data to 100%.  Then 

click on the 'Lock to view 100%' button.  If the user attempts to zoom out to full extent by using the ‘Fit to View’ button 

while this tool is activated, the following prompt will appear. 

 

If the user answers ‘No’ to the question above, MARS® will return the user to the LAS Map View window and the 'Lock to 

view 100%' tool will remain activated.  If the user chooses ‘Yes’ to the question above, the user will be able to zoom out to 

full extent with the 'Lock to view 100%' tool still activated.  If the user should need to deactivate this tool, it can be done by 

clicking on the button on the ‘View’ tab.  Another purpose of the prompt as seen above is to prevent a possible crash if 

MARS® attempts to display the full extent of the project area at 100% density. 

 

 

 

9. Contours: 

a) In Export: 

 The user can designate a ‘Max TIN Edge Length’ for contour export.  The length specified sets the maximum 

length of TIN triangle edges which are used in the export.  This option is applicable to both the ‘TIN’ and ‘Grid’ 

algorithm options on the ‘Contours’ tab in the export interface.  When using the 'Grid' algorithm, the software will 

create an ‘internal’ TIN to assist in the creation of the grid.  
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 MARS® can clip contours to an irregularly shaped boundary represented by a polygon shapefile.  This option is 

called ‘Clipping Data’ and is found on the ‘Layout’ tab of the export interface.  This option allows the user to 

browse to a polygon shapefile (other than the tile shapefile) in the ‘Boundary File’ box.  Using this option, the 

contours to be exported will be clipped back to the extent of the specified shapefile. 

 
 

 The 'Contours’ tab of the export interface offers the user the ability to specify an edge-tie tolerance.  The edge-

tie tolerance setting allows the user to set the distance between ends of two contour lines which will be joined or 

‘tied’ during export.  This tool only functions on the tile edge and will not join contour lines in any other area.  

The default edge-tie tolerance setting is 2 ground units.  This tool will look for same-elevation contour line ends 

which are 2 units or less apart at the tile edge and simply connect them, creating one unbroken contour line.  In 

the example below, two contours have reached the tile edge and have been cut at the tile edge.  This can occur 

whenever a project is processed by tile.  Because the ends of the two contours are 2 units or less apart and 

occur at the tile edge, they will be joined.  
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 The ‘Clean tolerance’ setting in the ‘Contours’ tab lets the user set the minimum distance between vertices of 

contour lines.  This tool only functions on the interior of a tile/export area and will not ‘clean’ line work at 

tile/project edges.  The default tolerance setting is 0.01 ground units.  This tool will look for contour lines with 

vertices which are 0.01 units or less apart and simplify them, removed unneeded vertices.  In the example 

below, the two vertices indicated are less than 0.01 units apart.  Rather than keep the sharply jutting area of the 

contour line intact, the software will create a more aesthetically pleasing contour line by deleting this spike.  The 

tolerance may be set to any value by the user. 

 

 

• An option named ‘Edge-tie directory of existing shapefile’ is located on the ‘Contours’ tab in the export interface. 

This option allows the user to point to an existing folder containing contour shapefiles.  This folder cannot be the 

same as the output folder.  The existing contours MUST contain an 'Elv' attribute field with the elevation values 

populated for each contour.  This allows the program to 'edge-tie' each contour line being exported to contours in 

previously created shapefiles.  Often, contours lines are cut when data is dissected into tiles.  The elevation of 

contour lines created separately in these tiles may not match up when tiles are placed back together to create a 

single dataset.  This option inside the contour interface creates a scenario in very few contours will be left 'dangling' 

or not connecting properly with the continuing contour line in another tile. 

 
 To further save QA/QC time, both the ‘TIN’ and ‘Grid’ export algorithms in MARS® have been refined to prevent 

the software from exporting contours with dangles, self-intersections, and overlaps. 

 

b) With Breaklines: 
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 Contours will respect all breaklines whether they are loaded into MARS® as reference breaklines or are fully-

functioning breaklines.  In the example below the user can see; a) contours created in MARS® over a river with 

NO breaklines enforcing the riverbanks and, b) contours created in MARS® over a river with breaklines loaded. 

Because the breaklines create a level surface between the two shorelines, contours do not cross the river. 

a)                                                                     b) 

       
 

 MARS® can display contours with only breaklines loaded.  It is not necessary to have LAS data loaded to view 

contours. 

 

c) Color: 
To make contour lines more easily visible against certain background colors and therefore more easily QC’ed, the user 

has the option of changing the display color.  To use this feature, click on the ‘Virtual Contours | Options’ button on the 

‘Analysis’ tab.  Click on the box to the right of the word ‘Color’ to select a new color.  The user may choose from the pre-

defined color palette or define a custom color.  An example of the ‘Contour Options’ and the ‘Color’ window may be seen 

below. 
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d) 100% View: 

MARS® will show Virtual Contours only when the user is viewing the LiDAR data at 100% point density. 

  

This example shows that the user is currently zoomed in to 33%. 

This density percentage value can be found on the left side of the Status Bar. 

 
Zoom in until the percentage of points displayed equals 100% or enable the ‘Lock to view 100%’ button.  The 'Area to 
Display' tool cannot be used unless the user is displaying the data at 100% density. 

 

e) ‘Contour Join’ Tool: 

This tool , found on the ‘Tools’ tab, allows the user to join (dissolve) multiple contour lines into one 

continuous contour line.  Only contours that share endpoints, and are the same in type and elevation, can be joined. 

 

For example, the screen shot below shows a contour line which was split between the two tiles shown during export, and 

remains as two separate lines after merging the contour shapefiles together.  These two lines truly represent a single 

contour line. 

                     
In the figure below, the 'Contour Join' tool has been run on the same contours as shown above.  The contour which was 

cut at the edges of the two tiles during export is now re-joined into a single feature.  

It was joined where indicated by the white circle.  

 

 

10. ‘Swipe Raster Over LiDAR’ Tool: 

Another QA/QC tool available from MARS® is the 'Swipe Raster Over LiDAR' tool found on the ‘View’ tab.  Both a raster 

image and LiDAR data must be loaded to use this tool.  When checking the alignment of these two data types, it is most 

advantageous to have the LiDAR data in TIN mode.  
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 Swipe Raster Over LiDAR: This tool allows the user to move imagery over LiDAR data for rapid viewing of 

alignment between LiDAR and imagery.  

The MARS® screen shot below shows the swipe tool working between imagery and LiDAR data. 

 

 

 
 
11. Coverage Tracking Tools (available with Production license only): 

The Coverage Tracking Tools (on the ‘QA/QC’ tab) are designed to make a polygon shapefile that tracks where the user 

has been in the project.  This helps to document which areas of a project have been edited or checked.  This toolbar 

works like a recorder in that the user can start tracking, leave the tool running while performing edits or checks, and then 

stop tracking.  The user is also capable of saving the recorded shapefile for later use. 

To use this tool, simply click on the ‘Start Coverage Tracking’ button.  The software will begin to track the movement of 

the editor and the area which was seen on the screen each time the editor panned across the project.  When editing or 

QC is complete, click the ‘Stop Coverage Tracking’ button.  After recording has been stopped, click the ‘Save Tracking 
to Shapefile’ button if desired.  The software will create a polygonal shapefile noting every extent that was viewed by the 

editor while the recording was running. 

 

1)  Start Coverage Tracking: Use this tool when checking, editing, or during any other activity where it is 

useful for the user to track movements across the project. 

2)  Stop Coverage Tracking: Select this button to stop the recording process.  At this time, the user’s 

movements across a project will no longer be noted in the shapefile created when the tracking path is saved. 

3)  Save Tracking to Shapefile: When the user has started and stopped a recording tracking the 

movements across a project, the recording can then be saved as a polygon shapefile.  This shapefile will show 

the extents that have been viewed.  This can be useful in double-checking that a project area has been fully 

examined. 
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Example: Each blue rectangle represents an area of the MARS® map view window and the data that was viewed inside 

that area.  With this coverage tracking tool, it is easy to see that all the data below has been viewed in this sample data 

and no area was left unchecked. 

 
12. Contour by Collection Scan (not available with Evaluation license): 

Another QA/QC tool available within MARS® is the ‘Contour by Collection Scan’ option in the Contour Options interface. 

This tool generates individual contour lines based on the collection scans within the area-of-interest, which can help the 

user determine the overall accuracy of the collection scans in relation to each other.  This type of contour generation is an 

option within the ‘Contour Options’ dialog, which can be launched by clicking the ‘Virtual Contours | Options' 

 button. 
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The ‘Contour by Collection Scan’ option can be a useful tool for evaluating calibrated collection scan data and the 

overall accuracy of the project’s sensor alignment.  This methodology is typically utilized for a quick analysis of LiDAR 

data and is intended to support QA/QC activities.  The following steps outline how to generate contours by collection scan.  

 

1. Data Loading: Load LiDAR dataset (ex. LiDAR, imagery, tiles, control points, etc.) into MARS®.   

2. Data Rendering: Change the default point rendering to ‘Color by Classification’ , which will display all of the 

LiDAR data classifications.  Click the ‘View Classification’  button on the ‘View’ tab to launch the 

‘Classifications Display Settings’ dialog, which can be used to toggle specific data classifications on and off. 

Click the ‘Ground (All)’ button to render only the bare-earth points.  Zoom in to an area where there is an overlap 

of collection scans.  Click the ‘TIN’   button on the ‘View’ tab to switch from a point display to a TIN display to 

view the data more easily. 
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3. Contouring Options: Click the ‘Virtual Contours | Options’ button  on the ‘Analysis’ tab and enter the 

desired contouring options including selecting the ‘Contour by Collection Scan’ check box.  To generate ‘on-the-

fly’ contours, click the ‘Area to Display’  button and drag a box over the area of interest.  This action 

will cause MARS® to generate a set of contours for each of the included collection scans (see the figure below), 

which provides the user with a method to visually examine the contours in overlap areas. 
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4. Visual Analysis: The user will be able to quickly determine if the data has been properly calibrated and post-

processed by visually inspecting the coincidence of the collection scan contours.     

 

Collection scan contours that are very close in proximity with each other indicate excellent sensor calibration and data 

accuracy.  Collection scan contours that diverge or have a large spatial difference indicate poor sensor calibration and 

substandard data accuracy. 

 

13. Check for Crossing Breaklines (available with Production license only): 

This tool , found on the Breaklines tab, will search for any crossing breaklines in a project.  Breaklines loaded as 

'Reference Breaklines' will be included in the crossing check.  The user can choose which types of breaklines will 

participate in the check.  The software will only recognize crossings in which the Z value (elevation) of each line is 

different.  If the Z value of both breaklines is the same or if the breakline points have been snapped together the crossing 

will be considered an intersection and will not be counted.  The resulting 'Breakline Crossing' window will notify the user of 

the total number of breakline crossings and allow the user to pan to each instance by use of the 'Previous' or 'Next' 

buttons.  Each crossing will be marked with an X - the user can choose the size and color of the X symbol.  The user may 

choose from a set of pre-defined colors or create a custom color.  The available font size of the X symbol ranges from 1 to 

30.  The 'Clear' button allows the user to clear the number of recorded crossings and the X marking those crossings from 

the LAS Map View window.  In the 'Breakline Crossing' window seen below, the user has chosen to view the 1st crossing 

found out of 4 total crossings. 
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14. Scale Bars: 

 This tool (on the ‘View’ tab) will toggle on or off the display of scale bars in the LAS Map View window.  This allows 

the user to gauge the horizontal distances within a project on the screen. 

 

Please see the screen capture below as an example.  Note that the scale bars are located on the bottom and left sides of 

the MARS® LAS Map View window. 

 
 

There is a similar tool on the ‘Cross-Section/Profile’ tab to toggle an elevation scale on and off in the Cross-Section/Profile 

window.  

 

15. ‘Collection Scan Direction’ Option: 

The ‘Collection Scan Direction’ tool  (on the ‘View’ tab) allows the user to view the direction in which each collection 

scan was acquired.  The collection scan direction will be indicated with arrows pointing in the direction of acquisition.  The 

lines and arrows are color coded to match the color of the corresponding LiDAR data when rendered using the ‘Color by 

Collection Scan’  button.  
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The example below shows five collection scans color coded in white, pink, yellow, purple, and green.  By turning on the 

Collection Scan Direction tool, it is possible to see the corresponding arrows showing the direction of acquisition. 

 
This example shows the same five color coded collection scan direction arrows with the LiDAR data turned off. 

 

 

16. Z Delta/Flight Line Separation – JPEG 2000 

a. Color by Z Delta (not available with Evaluation license): 

This tool  will color the points in the LiDAR data by the vertical difference in adjacent flight lines.  Clicking the 'Color 
by Z Delta' button on the ‘View’ tab will bring up the options interface.  

 

  
 Increment: Specify here how many elevation units should be between principal colors. 

 Complete color cycle: This text box will automatically update to tell the user how many complete color 

cycles will be used based on the 'Increment' number entered. 
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 Using average TIN: If this check box is used, the Z delta will be determined using the average TIN value of 

all collection scans.  

 

 Pick a collection scan as a reference: This drop-down box is automatically populated with the collection 

scan numbers of the collection scans shown on the screen at the time the Color by Z Delta button was 

selected.  If the user would like to have the Z Delta be determined by the value of a particular collection scan, 

then this option should be used. Make sure the 'Using average TIN' check box is unchecked. 

 Display cut off value: The user has the option of entering a unit value in this text box which would be 

considered out of the realm of possibility.  For instance, in one collection scan a car may have been parked 

beside the road off which LiDAR points were collected. In the next (adjacent) collection scan the car is absent, 

and LiDAR points were collected from the road which was beneath the car.  Because the two collection scans 

collected slightly different data, they will vary vertically in this area.  The 'Display cut off' text box will tell the 

software to simply ignore data outside this value range.  If a value of 4 feet is entered, for example, the 

vertical discrepancy between a car on the side of the road vs. no car in the same location will be ignored. 

 
Example: The data in the screen shot below has been well boresighted.  The user has chosen a collection scan as a 

reference against the other collection scans, and the results show that most of the ground points are green.  This 

means the Z difference between any given collection scan and the collection scan which acts as a reference is less 

than the allowable tolerance set by the user.  The areas of yellow suggest a slightly larger Z difference.  The areas of 

orange suggest an even larger Z difference, and the red areas show the largest areas of Z difference.  The areas of red 

and orange should be QC’ed carefully to make sure that the areas of larger differences are explainable and a 

boresighting issue is not to blame. 
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b. Flightline Separation – JPEG 2000: 
This is an export type that is intended for use over an entire project database and produces a raster file output.  Images 

are generated based on the relative elevation differences between LiDAR data in overlapping areas.  These overlap area 

differences are color coded, allowing immediate detection of relative vertical accuracy problems.  The non-overlapping 

areas will show intensity gridded data for reference purposes only.  This tool is useful for rapidly assessing the 

consistency of the LiDAR dataset's elevations and is highly useful in boresighting.  Over hard surfaces (such as roads) the 

user can expect the elevations within the same ‘cell’ to be nearly equal regardless of the LiDAR collection scan from 

which the data originates.  Differences are an indicator of a potential mission anomaly (typically a GPS/IMU problem) or a 

post-processing data adjustment issue.  In areas such as forests or fields, where vegetation growth varies according to 

the time of year, understandable error may be seen.  The overlaid collection scan separation coloration will have a 

transparency set so that the output raster will still have some feature definition visibility from the background intensity 

rendering. 

A more accurate (and potentially more useful) variation of this export is the production of a Measurable RMSDz raster and 

Z difference value.  This option tests only in areas of overlap/sidelap and identifies only those Single Return points that 

are a minimum distance from points with other return values.  The ‘Search radius for single return clustering in data units’ 

value should be 10 times the Ground Sample Distance (GSD, also referred to as NPS) of the lidar data to help ensure that 

the areas used for the analysis are unobscured without omitting too many points to prevent an accurate result.  In this 

way, the data that is tested and exported is much more likely to be in bare earth (open) areas, especially if the ‘Display 

cutoff value’ (explained below) is small enough to weed out non-system anomalies but large enough to ignore differences 

caused by targets in one collection scan that are not present in an adjacent scan (a moving car, for example).  A good 

starting point is 10 times the ‘Elevation increment’ (also explained below). 

 

1) Start by loading the LAS data for the project to be analyzed. 

2) Click the 'Export' button  to open the drop-down list of export types.  Select ‘Flightline Separation - JPEG 
2000’ and click the ‘OK’ button.  Please see a screen shot of the export interface that pops up below. 
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3) On the ‘Output’ tab, specify an ‘Output Directory’.  Checking the 'Use temporary local disk space to speed up 
processing' box and specifying a local drive’s ‘Temporary Folder’ allows for faster processing, even if the output 

folder is on a network drive.  Browse to any local folder which has space available in it.  The export interface will 

display how much space is required and how much free space is in the folder selected.  If there is enough disk 

space, the export process will use the local space to improve performance.  If not, another drive/folder must be 

chosen.  The option for producing a Measurable separation value (RMSDz) raster (see second paragraph above) 

can be found in the lower-right corner. 

4) Select the classifications, returns, and collection scans for export on the 'Filters' tab.  At least one class, return type, 

and collection scan must be selected for export to take place.  By default, all classes and collection scans are 

used, but only Last Return points.  If the ‘Measurable RMSDz FSR’ option is used (see above), then Single 

Returns are used instead. 

5) The multi-threading tool is available for this export type.  It functions to speed up export by using a specified 

amount of a computer’s CPU processing power.  The multi-threading option can be found at the lower-right corner 

of the export interface.  Initially, the box will show the maximum number of threads the computer has available for 

processing.  Leave as is, or enter a lower number of threads to use in processing here.  If ‘1’ is typed inside this 

text box, it is equivalent to single-threading the process. For best performance, there should be a minimum of five 

(5) GB of RAM available (not just installed) per thread. 
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6) On the 'Grid' tab, click on the 'Colors Options' button to define the elevation increment and color representation 

options as seen in the screen shot below, then click ‘OK.’  When this is complete, choose the 'Export' button to 

export the data by collection scan separation.  

   
 

 Elevation increment: Specify here how many elevation units should be between principal colors.  To test 

against the USGS LiDAR specification (<= 10 cm Z difference), for example, a value of ‘0.05’ should be 

entered for projects in meters so that both green and yellow would be in compliance with the spec, but orange 

and red would not.  Projects in feet should use a value of ‘0.16’. 

 Use Intensity Threshold: Check this box to set high and low intensity value ranges.  Pixels meeting these 

criteria will be rendered in magenta and blue, respectively, and will be displayed on top of pixels rendered by 

collection scan separation. 
 Stretch Intensity: Uncheck to disable intensity stretching for the background image of the raster. 

 Display cutoff value: The user has the option of entering a unit value in this text box which would be 

considered out of the realm of possibility.  For instance, in one collection scan a car may have been present 

from which LiDAR returns were collected.  In the next collection scan the car is absent, and LiDAR points 

were collected from the road which was beneath the car.  Because the two collection scans collected slightly 

different data, they will vary vertically in this area.  The 'Display cutoff value' text box will tell the software to 

ignore data outside this value range.  If a value of ‘0.5’ meters is entered, for example, the vertical 

discrepancy between a car versus no car in the same location will be ignored.  A good starting point for this 

value is 10 times the ‘Elevation increment’. 
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 Transparency (0-100): The user can set the transparency of the collection scan separation coloration over 

the output raster.  The default value is set to 50.  As stated in the GUI itself, a value of 0 would show no 

intensity image and only show the collection scan separation coloration.  A value of 100 would show the 

intensity image only with no collection scan separation coloration. 

 

Example: The Color by Collection Scan Separation tool has been used to export the raster shown below.  The collection 

scan overlap is represented by the colored sections of data.  There is an east-west cross scan included in this example. 

The areas with no overlap are rendered by intensity value (gray-scale) only.  

 
 

Example: As defined by the user in the 'Collection Scan Separation Colors Options' window, the colors in the example 

below represent varying amounts of error.  Green represents areas with the least amount of Z difference between the 

collection scans, whereas red and orange areas show the user areas with larger amounts of Z difference.  These 

red/orange areas may point to problems with the GPS, IMU, or post-processing data adjustment.  In this example, the 

Color by Collection Scan Separation tool has colored a lake red.  For this particular data, the cross scan was flown a 

month after the other collection scans and the red coloration is explained in that the water level of the lake was not the 

same at the time of each scan.  On the other hand, the road by the lake should be at the same elevation in both collection 

scans.  The road is green, indicating that the cross scan and this particular collection scan are properly boresighted.  

 
 

The JPEG 2000 file produced by this export type will not automatically be loaded into MARS® when the export is complete 

unless the corresponding box is checked on the ‘Options’ tab of Export.  To view the resulting raster, please load it using 

the ‘Add Images’ button on the ‘Project/Data Preparation’ tab.  See the MARS® Help Topics file for more information, 

including a description of the raster and tables produced.  
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17. Hillshade 

a. Color by: 
A float grid colored by hillshade can be used to quickly and accurately find misclassifications after hand filter.  To view a 

float grid colored by hillshade, a float grid must first be loaded into MARS®.  To see the gridded, elevation float grid 

colored by hillshade, click on the 'Color by Hillshade'   button and hillshade will be calculated and displayed.  

Because hillshade is being calculated and displayed ‘on the fly’, display can sometimes be slow.  This tool may also be 

used to view a float grid in 3D (perspective) view.  Remember, only float grids can be colored by hillshade.  

 
 

 b. Export to JPEG 2000: 

LAS data loaded in MARS® can also be exported to a ‘Hillshade - JPEG 2000’ image.  A JPEG 2000 image, or *.jp2, is a 

much more compressed file than a float grid (or *.flt) file.  This allows the rendering of a *.jp2 to be much quicker than 

many other raster formats. 

 

• Exporting LAS data to create a ‘Hillshade - JPEG 2000’ image:  
1) Start by loading the LAS data for the project to be exported. 

2) Click the 'Export' button  and select ‘Hillshade - JPEG 2000’ from the drop-down list.  Please see a 

screen shot of the export interface that appears below. 
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3) On the ‘Output’ tab, specify an ‘Output Directory’.  Checking the 'Use temporary local disk space to speed up 
processing' box and specifying a local drive’s ‘Temporary Folder’ allows for faster processing, even if the 

output folder is on a network drive.  Browse to any local folder which has space available in it.  The export 

interface will display how much space is required and how much free space is in the folder selected.  If there is 

enough disk space, the export process will use the local space to improve performance.  If not, another 

drive/folder must be chosen. 

4) Adjust the sun ‘Azimuth’ and ‘Altitude’ angle values settings as desired.  The default values are 315 and 45. 

5) On the 'Layout' tab of the export interface, specify a file name for the newly created .jp2 file in the 'File' text 

box. 

6) If any other parameters of export need to be set, please make those entries in the remaining tabs of the 

interface.  

7) When all the conditions of the export have been set, click the 'Export' button at the bottom of the interface.  The 

progress bar, Elapsed Time, and Estimated Time to Complete will be displayed for the export. 

8) When the export is complete a pop-up will appear which informs the user that the export was successful. 

 

To see the newly created JPEG 2000 image, click the upper half of the 'Add Images' button on the 'Project/Data 
Preparation' tab.  Make sure the 'Files of type: JPEG 2000' is selected at the bottom of the 'Open' interface.  Navigate 

to the output folder previously designated and load the *.jp2 file.  Once loaded, the image can be found in the table of 

contents under ‘Rasters.’  This resulting image may be viewed only in 2D View. 
 
 
 

18. Ability to Add and View a Float Grid in 2D or 3D: 

To load a float grid into MARS®, click the 'Add Float Grid' button on the 'Project/Data Preparation’ tab.  Navigate to the 

float grid (*.flt) to be loaded and select it. Choose 'Open'.  
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Once a gridded, elevation float grid (*.flt) is loaded into MARS®, the user may pan or zoom around the data in 2D or 3D. 

To view the float grid in 2D, or orthographic view, make sure the 2D  button is selected on the toolbar.  To view the 

float grid in 3D, or perspective view, make sure the 3D  button is selected.  The example below on the left is a float 

grid of a stadium in 2D view.  The example below on the right is a float grid of the same stadium as viewed in 3D.  

     
 

19. ‘Flood Fill’ Tool: 

The ‘Flood Fill’ tool  is located on the ‘Analysis’ tab and will generate a flood fill in a specified region.  By applying this 

tool, the user may view areas of LAS data which would fill with water during a flood.  The user may specify the lowest 

elevation in which to apply the flood and then use the Elevation slider to simulate different flood severities.  The user may 

also choose the color and transparency of the flood fill.  It is also possible to save the flood fill to a 3D shapefile.  Check 

this option and choose a shapefile name and folder location, then click ‘Save’ to create the shapefile.  Click ‘Display’ to 

show the results of the flood. 

The examples below show the results of different flood severities.  The example on the left shows flooding up to an 

elevation of 5264 feet; the example on the right shows flooding up to 5279 feet. 
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Another example of a flood fill (3D view): 

 

 

 

20. Real-time LAS Shifting 

a. LAS Shifting (X, Y, and/or Z): 
Using a global data shifter to shift all the LAS files in an entire project can sometimes help the project meet specs.  This 

sort of shift can be done after hand editing is finished and a control report has been run to determine the average Z 

(elevation) error in a project.  To use this shifting tool, click on the 'XYZ Shift' button (available with Production license 

only) on the ‘Coordinate Conversion’ tab or highlight the file in the Table of Contents and click the ‘Shift’ button at the top 

of the table.  The shift tool is also used to shift data on the X and Y coordinates.  This tool is capable of shifting east (a 

positive value in the Translation East text box), west (a negative value in the Translation East text box), north (a positive 

value in the Translation North text box), or south (a negative value in the Translation North text box).  The shift tool can 

modify the elevation (Z value) of the data by entering a positive value (to move data up higher) or a negative value (to 

move data down lower).  In the MARS® Table of Contents, it is possible to select multiple LAS files and apply the 

necessary shifts to all of them.  Use the 'Shift' key on the keyboard to select several files in consecutive order, or use the 

'Ctrl' key on the keyboard to select several files in random order.  The selected files will all have the same shifts applied 

to them as specified by the user in the 'MARS LAS Shifter' interface.  When shifting LAS data using the Table of Contents 

'Shift' button, a *.off file (one per shifted LAS file) is created which stores the pre-shift X, Y, and Z offset values read from 

the LAS file header.  These files are created in the same folder as the LAS files that were shifted.  The *.off files are used 

as a baseline by the 'Report LAS Shift' tool to create a comma-delimited (*.csv) report that stores the total (cumulative) 

shift for each of the files chosen to be included in the report.  To use the tool, add one or more shifted LAS files using the 

'Add' button, or add an entire folder of shifted LAS files using the 'Add From Folder' button.  Choose a path and file 

name for the output CSV file - click on the ellipse button, then navigate to the desired output folder and enter a filename 

and finish by clicking 'Save.'  To create the report, click the 'Run' button at the bottom of the tool interface. 

 

**NOTE: Multiple shifts are cumulative. 
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b. Z Shift For LAS Files (available with Production license only): 
The 'Z Shift For LAS Files' tool, found on the ‘Coordinate Conversion’ tab, allows the user to batch shift the Z value, or 

level the elevation, of all LAS files in a project by use of a *.csv file.  This tool is meant for use after boresight has been 

completed.  The corresponding *.csv file must include a header row, the file names of the LAS files to be shifted, and the 

adjustment value to be made to each file.  It is important to note that the adjustment values to be made to each file need 

to be in the project units for that particular project.  A sample *.csv file may be seen inside the 'Z Shift For LAS Files' 

interface.  To use this tool, point to the LAS files by clicking on the 'Add' button in the top right-hand corner and add the 

LAS files which need flight line shifts.  To remove single or multiple files, highlight the file(s) to be removed and click on 

the 'Remove' button. Specify the corresponding *.csv file in the 'Spec File (CSV)' section and designate an output folder.  

If no output path is specified, the original LAS files will be overwritten. 
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c. Z Shift On Intensity (available with Production license only): 
This tool, found on the ‘Coordinate Conversion’ tab, is capable of shifting LAS data that matches a specific user defined 

intensity value.  The ‘Z Shift Value’ is also defined by the user.  After the LAS data is loaded into the ‘Z Shift On Intensity’ 

tool, the user can make entries in the text boxes provided to specify an ‘Intensity’ value that will be shifted, and the ‘Z Shift 

Value’ to apply to those intensities.  An output folder can be designated to create a new dataset (rather than overwriting 

the original files) and progress can be tracked inside the ‘Z Shift On Intensity’ interface. 

 

 

 

d. Z Shift On Class (available with Production license only): 
This tool, found on the ‘Coordinate Conversion’ tab, is similar to the 'Z Shift On Intensity' tool, but instead is capable of 

shifting the Z value of LAS data by classification.  After the LAS data is loaded into the ‘Z Shift On Class’ tool, the user 

may access the text boxes provided to specify a 'Class’ value (or values) that will be shifted, and the ‘Z Shift Value’ to 
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apply to those classes.  An output folder can be designated to create a new dataset (rather than overwriting the original 

files) and progress can be tracked inside the ‘Z Shift On Class’ interface. 

 

 
 
 
 
 
 

21. Collection Scan Polygon Generator Tool: 
This option, found on the ‘Vector Creation’ tab, allows the user to generate a polygonal shapefile based on collection 

scans from LAS data acquisition.  The user may choose which algorithm the process will use to generate the polygons: 

'TIN' or 'Grid': 

• 'TIN': If the user selects this option, the edges of the polygonal shapefile(s) will be created based on the edge of 

the virtual TIN which is created. MARS® will use 3 points to create a TIN and the edge of this TIN will denote the 

edge of the polygonal shapefile.  

• 'Grid': If the user selects this option, the edges of the polygonal shapefile(s) will be created based on the edges of 

a virtual grid.  When this option is selected the user may further specify a cell size.  The default cell size is 3 – in 

other words, the virtual grid is 3 ground units by 3 ground units in size.  The cell size should be greater than or 

equal to the ground sample distance (GSD).  MARS® looks for points within the specified virtual cell size grid and 

establishes the edges of the collection scan data by determining whether or not points exist in a cell.  When points 

are no longer located, the edge of the collection scan is confirmed. 

The user may also choose the following option when creating the polygons:  

• 'Perform full statistics': If this option is chosen, density and GSD per classification per collection scan will be 

calculated on the classes which are specified in the 'Class Statistics' section.  This section will become available 

when the 'Perform full statistics' option is chosen.  Make specifications by clicking on the 'Select' button. 

 

The user will then need to browse to a folder of LAS files to be used in generating the polygons.  For the 'Output 

Shapefile,' navigate to the folder in which the newly generated shapefile should be stored and give it a name.  Click the 

‘Generate' button to start the processing.  A message will appear when the process is complete. 
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The newly created *.shp may then be brought back into MARS®.  If the ‘Perform full statistics’ option was checked, the 

user can right-click on the new shapefile in the Table of Contents, choose 'Attributes' and view an attribute table specific 

to that shapefile.  The attribute fields included in the statistics are: the file name, collection scan numbers, all points count, 

area, density, average GSD, the minimum intensity, the maximum intensity, the mean intensity, median intensity, and 

mode of the intensity values.  Also included are: minimum and maximum GPS time values, the point count for each class 

included in the collection scan polygon generation, and other fields as described in LAS Statistics (above). 

 

 
 

 

Below is the resultant reference shapefile loaded into MARS®.  The shapefile is comprised of ‘footprints’ of each of the 

collection scans contained in the LAS files chosen by the user.  This can be a useful tool in checking the overlap between 

collection scans and making sure there are no gaps in the data. 
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22. ‘Swath shapes to overlap JP2’ Tool (available with Explorer QC and Production licenses only): 
 
This tool, found on the Tools Tab under the 'Format Conversion' drop-down, converts a folder of swath footprint shapefiles 

into a single JPEG 2000 raster for lidar collection coverage checking.  Uniquely named swath footprint shapefiles from 

multiple missions are placed in a single input folder, and an output folder and filename are specified.  The required project 

ANPD (Aggregate Nominal Pulse Density) is entered in points per square meter, and the horizontal units of the project 

data – Meter, U.S. Survey Feet, or International Feet - are selected from a drop-down list. 

 

 
 

The output raster uses the same color coding as the 'Flight Line Overlap' raster in test DC10.1 of the Lidar Data Checks 

tool: 

 
 

 

23. Batch Script Test Function to Step (Forward or Back) Through Macros: 
 

The purpose of these tools (on the ‘Edit/Filter’ tab) is to allow the user to run through macros step by step (manually) 

rather than running a script from start to finish.  Steps can be run one-at-a-time and the user can easily distinguish the 

breaks between filters.  This allows the user to stop processing at any point to see the effects an individual filter may have 

on the data as well as to edit the filter options.  Manual/GUI (graphical user interface) methods are slower than automated 

processes, so this method should only be used for testing.  ‘Batch Process Tiles’ is run in RAM and can run behind the 

scenes much more quickly for higher performance. 

 

 

: This button allows the user to start a step-by-step run through each filter of the selected macro (ex. 
@: Canopy) for a specified test area (determined by dragging a box). 
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: This tool allows the user to step to the next filter of a macro.  Pressing this button once will only run 
through the next single filter in the macro. 

 

 : This tool rolls back the actions of the previous filter in the macro. 
 

: Proceed through all steps of the macro to the end. 

: Stop the filtering process.  This tool is used after the ‘Go’ button has been clicked to stop the process of 
the filter at the current step without canceling the action entirely. 

 

: Restart filtering process from the beginning of the macro. 
 

: Will bring up the edit dialog window to modify any filters in the loaded macro. 
 

On the Status Bar, the user will find a short summary of the filters found in the loaded macro.  The first number tells the 

user the filter number (step) that has just been run (ex: 6/18: the software is currently processing or has just completed 

the sixth filter in a macro which has a total of 18 filters).  The name of that filter will be shown next to these numbers.  This 

is to give the user an overall idea of where the macro is in processing and to let the user know which filter is running if it 

should need to be edited or removed from the macro. 

 
 
 
 

24. ‘Convert SBET to Shapefile’ Tool and ‘Scan Angle’ Filter Tool: 
The final step in a typical workflow is to produce an SBET, or Smoothed Best Estimated Trajectory file.  This means 

computing the tightly integrated position and orientation solution using the correction observations, the raw GPS and 

inertial data extracted from the workflow.  The data is processed in both the forward and backward directions in order to 

produce the optimal solution, smoothing the effect of GPS outages and other aberrations in the data.  This results in the 

best possible position and orientation solution for a given dataset, usually maintaining centimetric accuracy for 

significantly more time and at longer distances than would be possible with traditional GPS processing.  The output from 

this process is referred to as an SBET.  The 'Convert SBET to Shapefile' tool will create a 3D shapefile from an SBET file, 

giving the user the ability to visualize the SBET overlaid on LiDAR data.  This tool does require some previous knowledge 

of geodesy.  Among many other purposes, the 'Convert SBET to Shapefile' tool can be used to see how centered in the 

scan the SBET is, and the resultant shapefile can be used in the ‘Scan Angle’ filter. 
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Once the conversion is finished the user may now load the newly created 3D shapefile into MARS®.  This is done by 

going to the 'Project/Data Preparation' tab and clicking the 'Add Reference Shapefiles' button.  Navigate to the output 

folder which was specified in the 'Convert SBET to Shapefile' interface and select the *.shp file which matches the name 

of the SBET used to create it.  In the example below, the 3D shapefile created from the SBET is loaded along with the 

corresponding LiDAR data.  
 

 



February 1, 2023 Page 47 

To enter ‘Scan Angle’ filter settings and use this tool, choose ‘Scan Angle’ from the 'Filter Action' drop-down list on the 

‘Edit/Filter’ tab.  Click the 'Filtering Options'  button, which will bring up the appropriate interface to 

enter in the desired settings.  The Scan Angle filter is made specifically for use with the 'Convert SBET to Shapefile' tool. 

The Scan Angle filter uses an SBET file which has been converted into a 3D shapefile to reclassify certain sets of points. 

Remember that the 3D shapefile used in this filter represents the SBET, and this is the actual path of the plane in flight. 

The LiDAR data, which represents the ground beneath the plane, is collected at different angles in relation to the plane. 

See the diagram below for further explanation: 

 
 

In this filter, the points are reclassified based on the scan angle (actually, the scan angle rank).  In the diagram above, the 

points collected on the ground at the bottom of the blue arrow represent a different scan angle than those points collected 

at the bottom of either of the red arrows.  This filter reclasses points based solely on their scan angle rank.  The user may 

enter several different parameters based on minimum and maximum scan angle ranks, resulting in several different 

classes of points, each representing a separate scan angle rank range (see example below).  This filter can be used to 

run statistics of density per class or to run statistics based on the density of the scan angles.  

 

 
 
 

25. ‘Single Collection Scan to Multiple’ Tool (available with Production license only): 
This tool (under the ‘Collection Scans’ drop-down on the ‘Tools’ tab) will split a single collection scan into multiple, smaller 

collection scans in areas indicated by the flight heading, or angle, which is user defined.  Having multiple, smaller 

collection scans versus a single, large collection scan may help in boresighting and in measuring elevation differentiations 

between collection scan overlaps.  
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1. To use this tool, first load the LAS data which coincides with the large collection scan (that is to be separated into 

multiple smaller collection scans) by choosing the 'Add' button.  

2. To remove added LAS files, simply select the file to be removed and choose the 'Remove' button. 

3. Next point to the SBET shapefile which is associated with the LAS file(s) loaded.  

4. Specify the sampling rate at which to produce the new collection scans by entering an integer into the 'Use every 

__ points in the shapefile' text box.  This feature of the 'Single Collection Scan to Multiple' tool allows the user to 

reduce the sampling rate of (or thin out) the heading data from the SBET file by allowing the user to define a time 

range. 

 

The examples shown below depict a 1 second sampling rate (left) and a 30 second sampling rate (right). 

   
 

5. The use of the ‘Match date stamp in SBET file name and LAS file name’ checkbox is explained in the Help Topics 

within the MARS® software. 

6. Define an output folder for the new multiple collection scans. 

7. Choose a starting collection scan number for the naming convention of the new multiple collection scans to be 

created. 
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8. Choose an angle at which collection scans will be separated.  Whenever the angle specified here is found in the 

single collection scan, the process will split the collection scan into separate scans. 

9. When all settings have been entered, click the 'Run' button. 

10. When the process is complete the user will be notified with a prompt as seen here: 

 
 

In the example below on the left, the LAS data is shown colored by collection scan.  There is only a single, long collection 

scan loaded.  The SBET shapefile is shown as the pink point shapefile.  In the example on the right, the collection scan 

shown previously has been converted to multiple collection scans (each discrete color) with the collection scan angle 

specified for separation at 90 degrees. 

           
 

 

26. ‘Z Fix Using Stream Rule’ Tool (available with Production license only): 
This tool, found on the ‘Tools’ tab, will test and fix (if necessary) a 3D breakline shapefile to maintain monotonicity.  In a 

hydrography context, monotonicity is the principle that elevations (Z-values) must decrease, or at least stay flat, as a 

breakline goes from uphill to downhill. 

 

No data needs to be loaded to use the tool.  Path out the 3D breakline shapefile to be tested in the ‘Input’ section and the 

new (corrected) output shapefile in the ‘Output’ section.  Then choose either the ‘Run’ button (Z-values rounded to three 

decimal places) or the ‘Run (EDH Drape)’ button (no rounding done) to start the tool.  If a Z-value is detected that is 

higher than the previous uphill value, that previous value is copied to the 'bad' vertex.  When the input shapefile has 

polyline geometry but contains both unclosed and closed features, two output files will be generated -- <name>.shp and 

<name>_Polygon.shp.  The original input shapefile is never altered with this tool. 
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MARS® Technical Support – General Information 

 

o Technical Support Hours: Weekdays from 9:00 AM – 5:30 PM (U.S. Mountain Time Zone) 
o Toll-free Telephone: (800) 544-1714 
o E-mail:    MARSsupport@merrick.com 
 

Technical Support Contact 

 

 Mark A. Stucky - MARS® Technical Support Specialist (United States/Canada) 
Office:  (303) 353-3933 

E-mail: mark.stucky@merrick.com 

 

Social Media 

 

 

 

Please follow Merrick & Company for the latest MARS® product announcements, feature enhancements and 
user tips! 
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